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 1 Introduction to Comodo Antivirus
Comodo Antivirus (CAV) offers complete protection against viruses, worms and Trojan horses for MAC OS X based computers. 
The software is easy to configure and use and features real-time, on-access and on-demand virus scanning, full event logging, 
cloud based behavior analysis of unknown files and more. Users can start virus scans immediately by clicking the 'Scan Now' 
link on the summary screen. Individual files can be checked for viruses at any time by dragging them into the scan box in the 
'Summary' area or, if the interface is not open, by dragging them onto the Comodo dock icon. 

• Detects, blocks and eliminates viruses from desktops and networks
• Constantly protects with Real-Time and On-Access scanning
• Built in scheduler allows you to run scans at a time that suits you
• Isolates suspicious files in quarantine preventing infection 
• Daily, automatic updates of virus definitions
• Simple to use: install and forget while Comodo Antivirus protects you in the background 

Gu ide  S t r u c t u r e
This introduction is intended to provide an overview of Comodo Antivirus. Please use the links below to jump to the section that 
you need help with. 

• Introduction to Comodo Antivirus
• System Requirements
• Installation
• Starting Comodo Antivirus 
• The summary screen
• Navigation 
• Understanding Alerts 
• How To... Tutorials

• Antivirus Task - Introduction
• Run a Scan 
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• Update Virus Database 
• Quarantined Items
• Viewing Antivirus Events 
• Submit Files to Comodo for Analysis
• Scheduled Scans 
• Scan Profiles 
• Scanner Settings 

• Real Time Scanning
• Manual Scanning
• Scheduled Scanning
• Exclusions

• More... Options
• Preferences

• General Settings
• Parental Control Settings
• Language
• Log Settings
• Update Settings

• Manage My Configuration
• Diagnostics
• Check For Updates 
• Browse Support Forums 
• Help 
• About 

 1.1 System Requirements
To ensure optimal performance of Comodo Antivirus, please ensure that your computer complies with the minimum system 
requirements as stated below.

COMODO AV solution should be compatible with the following hardware platforms:
• Mac PPC 32 bit 
• Mac PPC 64 bit 
• Mac Intel i386 
• Mac Intel x86_64 

Operating systems:
• Mac OS X 10.4 
• Mac OS X 10.5 (Client and Server) 
• Mac OS X 10.6 (Client and Server)

 1.2 Installation

In order to install Comodo Antivirus, you need to download the setup file from 
http://download.Comodo.com/cis/download/installs/mac/CAVSetup.dmg.zip  

After downloading to your local hard drive, double click the Comodo Antivirus .dmg setup file. Double click 'Comodo Antivirus 
Installer' to start the installation wizard: 
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S t ep 1  -  Choo s i n g  t h e  I n t e r f a c e  L anguage

The installation wizard starts automatically and the 'Select the language' dialog is displayed. Comodo Antivirus is available in 
several languages.

• Select the language in which you want Comodo Antivirus to be installed from the drop-down menu and click 'OK'. 
S t ep 2  -  End Use r  L i c en s e  Ag r e emen t

The End-User License Agreement dialog box will be displayed.
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To continue with the installation, you must read and then accept the End User License Agreement (EULA). Click  'I accept' to 
continue the installation. If you want to cancel the installation at this stage, click 'Cancel'.

S t ep 3  -  F r e e  P roduc t  Reg i s t r a t i on

Comodo Antivirus is activated free of cost for lifetime usage. If you wish to sign up for news about Comodo products then enter 
your email address in the space provided. This is optional. 

 Click 'Next' to continue.
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S t ep 4  -  Con f i rma t i on d i a l o g

After completing the configuration options to your satisfaction the setup wizard will ask for confirmation before commencing the 
installation procedure.

Click the 'Back' button to review and/or modify any of settings you have previously specified. To confirm your choices and begin 
the installation of the Comodo Antivirus, click 'Install'.

The setup status box will be displayed. You will see a progress bar indicating that files are being installed.

STEP 5  -  I n s t a l l a t i on  Comp l e t e  

The Installation Complete dialog is displayed indicating the successful completion of installation.
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Click 'Finish'.

For the installation to take effect, the system has to be restarted.

Click 'Yes' to restart your system. 

 1.3 Starting Comodo Antivirus
After installation, Comodo Antivirus will be automatically loaded whenever you start your computer. Real-time protection and on-
access scanning is automatically enabled so you are protected immediately after the restart. To configure the application and 
view settings, you need to access the management interface. 

There are two main ways to do this - by  clicking the taskbar icon or by clicking the dock icon.
Open by clicking the taskbar icon

To open the interface, click the CAV taskbar icon as shown: 

Th i s  wi l l  op en Comodo An t i v i r u s  a t  t h e  Summar y  s c r e en .  We r e c ommend you r  f i r s t  t a s k  
s h ou l d  be  t o  r un a  f u l l  s c an on you r  c ompu t e r .  C l i c k  ' D o  i t  now '  unde r  t h e  y e l l ow 
s h i e l d  on t h e  l e f t  t o  s t a r t  a  f u l l  s c an .  A l t e r n a t i v e l y ,  s e e  ' The Summary Screen'  and 
' Antivirus Tasks - Introduction'  i f  you wi sh t o  l e a r n  more  abou t  t h e  app l i c a t i on .
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Open by c l i c k i ng  t h e  dock i c on

Comodo An t i v i r u s  wi l l  au t oma t i c a l l y  add an app l i c a t i o n  qu i ck  l a un ch i c on  t o  
t h e  MAC OS do ck .  You c an open t h e  i n t e r f a c e  a t  any  t ime  by  c l i c k i ng  t h e  i c on 
a s  s h own :  

T ip :  You c an r un s c an s  on any  f i l e  o r  f o l d e r  by  s imp l y  d r agg i ng  i t  on t o  t h e  
CAV do ck  i c on .  If, for whatever reason, this icon is removed or is not present and you wish to manually add it then 
please follow these steps:

Doub l e  c l i c k  'Ma c i n t o s h  HD '  on you r  de s k t op :  
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• Click 'Applications' then double-click the 'Comodo' folder: 

• Click and hold the 'Comodo Antivirus' icon and simply drag it down to the dock. 
• From now onwards, you will be able to open the application by clicking the dock icon. 

 1.4 Comodo Antivirus - The Summary Screen
The 'Summary' screen is shown by default when you open the application. It provides an at-a-glance summary of protection and 
update status as well as allowing you to quickly run a virus scan with a single click. You can access this area at any time by 
selecting the 'Summary' tab as shown in  General Navigation. 
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Individual files can be scanned for virus by dragging them into the scan area.

The summary screen contains the following information: 
1 . System Status 

The shield icon on left-hand strip of the interface is a highly visible heads-up on your current protection level. In the 
example above, we see a yellow icon indicating that there are actions you need to take (run a full scan). Once you 
have done this (and providing 'Real Time Scanning is not disabled), the shield icon should turn green and display the 
message 'All systems are active and running'. 

2 . Antivirus 

The Antivirus summary box contains: 

i. The Status of Realtime Virus Scanning 
The status of the virus scanning setting is displayed as a link (Stateful in this example). On clicking this link, 
the Virus Scanner Settings panel is opened allowing you to quickly set the level of Real Time Scanning, by 
moving the status slider. For more details on Virus Scanner Settings, refer to  Scanner Settings

ii. When the Virus Database was Last Updated 
The day and time at which the virus database was last updated is displayed as a link. On clicking the link, 
the update of the virus database is started and the current date and time are displayed on completion of the 
process. 

iii. Number of Detected Threats 
The number of threats detected so far from the start of the current session of Comodo Antivirus is displayed 
here as a link. On clicking the link, Antivirus Events panel is opened. For more details on viewing Antivirus 
events, refer to  Antivirus Events.

iv. Scan Now 
The 'Scan Now' link in this box allows you to instantly  Run a Scan.
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 1.5 Comodo Antivirus - Navigation 
The Comodo Antivirus interface is divided into three main functional areas - 'Summary', 'Antivirus' and 'More'. You can access 
any of these areas by clicking the icons along the top of the interface. 

• Summary -  Contains at-a-glance details of important settings, activity and other information. 
• Antivirus - Opens the Antivirus Tasks configuration section. This area allows you to run scans, configure 

settings, schedules, updates, scan profiles and more. 
• More - Opens the More options screen which contains options relating to the overall configuration of Comodo 

Antivirus. 
Each of these areas contains several sub-sections that provide granular control over the configuration of the application. 

 1.6 Understanding Alerts

Antivirus alerts immediately inform you if a virus has been detected and provide options and information so you can make an 
informed decision on how to proceed. Alerts can also be used to instruct Comodo Antivirus on how it should behave in future 
when it encounters activities of the same type. 

Answering an Antivirus Alert
Alerts are generated whenever a virus or malware tries to be copied to or run on your system. Alerts appear at the bottom right 
hand side of your computer screen. The alert contains the name of the virus detected and the location of the virus on your disk 
and, if available, more information about the virus.

Each alert has two main options - 'Clean' and 'Ignore'. Selecting either of these will present further options.

• Clicking 'Clean' will allow you to:
• Quarantine the file. This will move the file to  Quarantined Items 

OR
• Disinfect the file. If CAV has a disinfection routine available it will disinfect the file. If not, then the file will be 

deleted.
• Clicking 'Ignore' will present you with the following options:

• Once - If you click 'Once', the file is ignored this time only. If the same file is detected at another time then 
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another alert will be displayed.
• Report this to COMODO as a False Alert - If you are sure that the file is safe, select 'Report this to Comodo 

as a False Alert'. This will submit the file to Comodo for analysis. If the file is found to be trustworthy, it will be 
added to the Comodo whitelist.

• Add to Exclusions - If you click 'Add to Exclusions', the virus is added to your local Exclusions list. This 
means Comodo Antivirus will no longer report this file as malicious or raise an alert the next time the file is 
detected.

Ignore the alert only if you trust the application. 
To move t h e  f i l e  o r  app l i c a t i on t o  Qua r an t i n e

• Click the drop-down arrow beside the 'Clean' button and select 'Quarantine' from the 'Clean' options.

To d i s i n f e c t  t h e  f i l e / app l i c a t i on

• Click the drop-down arrow beside the 'Clean' button and select 'Disinfect' from the 'Clean' options.
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Comodo Antivirus will first attempt to disinfect the file in question. If this is not possible, then the file will be deleted. 

To i g no r e  t h e  a l e r t  i f  you t r u s t  t h e  f i l e / app l i c a t i on

• Click 'Ignore'. Selecting Ignore provides you with three options.

• Once. If you click 'Once', the file is ignored this time only. If the same file is detected at a later date then another 
alert will be displayed.

• Report this to COMODO as a False Alert. If you are sure that the file is safe, select 'Report this to Comodo as a 
False Alert'. This will submit the file to Comodo for analysis. If the file is found to be trustworthy, it will be added to 
the Comodo white-list.

• Add to Exclusions. If you click 'Add to Exclusions', the virus is moved to Exclusions list. This means Comodo 
Antivirus will no longer report this file as malicious or raise an alert the next time the file is detected.

 1.7 Comodo Antivirus - How To... Tutorials

The 'How To...' section of the guide contains guidance on key tasks of Comodo Antivirus. Use the links below to go to each 
tutorial's page.

• How to Scan your Computer for Viruses - Explains how automatically or manually you scan your computer
• How to Configure Database Updates - Displays the range of various of updating the Antivirus Database
• How to Quickly Setup Security Levels - Guidance on changing the current security levels of Antivirus 
• How to Password Protect your CAV settings - Explains how to protect your CAV settings 
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• How to Run an instant Antivirus scan on Selected Items - Guidance on initiating a manual scan on selected 
folders/files to check for viruses and other malware 

• How to Create a Scheduled Scan - Guidance on time-table scheduling of antivirus scans to be run on selected items 
at selected intervals 

• How to Restore Incorrectly Quarantined Item(s) - Help to restore files and executables that were moved to 
quarantine by mistake 

• How to Submit Quarantined Items to Comodo for Analysis - Advice on how to send suspicious files/executables to 
Comodo for analysis 

• How to Switch Off Automatic Software  and  Antivirus Updates - Explains how to stop automatic software and 
virus updates 

• How to Temporarily Suppress Alerts when Playing a Game - Helps you to switch off CAV pop-up alerts to avoid 
interruptions while playing games

• How to View Antivirus Reports - Helps to view all  scan events 

 1.7.1 How to Scan your Computer for Viruses
Comodo Antivirus allows you to quickly run an on-demand scans of any area or item on your computer.

• To start a manual scan of your whole computer or specific location(s) 
• To run a quick scan on a particular item

To start a manual scan of your computer or specific location
• Open the 'Run a Scan' dialog by selecting 'Scan Now' from the summary screen. The interface can also be opened by 

clicking the 'Antivirus' tab followed by 'Run A Scan'. 
Either method will open the 'Run a Scan' dialog:

• You have two broad options:
• Choose to run a predefined scan profile. 'My Computer' will scan your entire system while 'Critical Areas' is a 

targeted scan of very important files and folders. 
Select the profile you want then just click the 'Scan' button to run a scan of a predefined area

OR

• Choose to Create A New Scan. As the name suggests, this allows you to create a custom scan of precise 
areas of your system (drives. folders etc). See custom scan. if you would like to know more about this 
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option.
After clicking the scan button, Comodo Antivirus will first check for database updates. If they are available, they will be 
downloaded and installed before the scan runs. 

Scanning will commence immediately after any updates are applied.

The progress dialog shows the following items: profile name, the scanned location, the start time and duration of the scan, the 
total number of objects scanned and the number of threats found. 

On completion of scanning, the scan  results screen will list the names and risk levels of  all the threats found.

Note the 'All?' check-box in the top left corner is enabled, meaning your choice of 'Clean' or 'Ignore' will apply to all listed items.

Click the 'Clean' button to disinfect selected threats or move them to Quarantined Items.  

Clicking 'Ignore' button allows you to ignore file(s) once, report the file(s) to Comodo as a false positive or create an exclusion for 
this file(s). If required, you can save the scan results as a text file by clicking the 'Save Results' link.

For more details on quarantined applications, refer to  Antivirus Tasks > Quarantined Items
For more details on ignore options, refer to Ignore an application/file. 

To create a new scan profile
• Click 'Create New Scan' in the 'Run a Scan' interface. 
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• Type a name for the scan profile to be created in the 'Name' box.
• Click 'Add'.
• Select the locations to be scanned when the newly created scan profile is selected.

• Select the locations from the left column, drag and drop to the right column or select the locations and click right arrow 
to move selected folders to right column. 

• Click 'Apply'.
For more details on scan create, refer to Creating a Scan profile.

To run an instant scan on a particular item
You can instantly virus scan virtually any file, folder, photo, application or hard-drive by simply dragging the item into the scan 
box on the summary screen or onto the Comodo icon on the dock. 
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Please refer for more details to Starting Comodo Antivirus. See also how to create a Scan Schedule.

 1.7.2 How to Configure Database Updates
To ensure maximum security and protection against the most recent virus outbreaks, it is essential that all scans are run using 
the latest virus database. For this reason, it is the default policy of CAV to (1) Periodically check for and download database 
updates and (2) Automatically check and update the virus database before starting any scan process. Updates can also be 
downloaded manually and pre-scan update checks can be disabled on a per-scanner basis.

• To manually update the virus database
• To configure automatic database updates
• To configure pre-scan database updates

To manually update the virus database
• Click the 'Antivirus' from the top navigation
• Click 'Update Virus Database'
• CAV will contact Comodo servers and, if available, will download and apply the update. 
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 Note: You must be connected to Internet to download the updates.

To configure automatic database updates
To switch automatic updates ON/OFF in absolute sense:

• Click the 'Antivirus' button along the top navigation
• Click 'Update Virus Database'
• Make sure the interface is open at the 'Real Time Scanning' area
• Enable or Disable 'Automatically Update Virus Database'

To configure pre-scan virus database updates
Pre-scan update checks can be switched ON/OFF on a 'per-scanner' basis for 'On Access' and 'Scheduled' scan types. To do 
this:

• Click 'Antivirus' from the top navigation
• Click 'Scanner Settings'
• Select either the 'On Access Scanning' or 'Scheduled Scanning' button as per requirements
• Enable or disable the 'Automatically update virus database' checkbox as per requirements

More details on these settings can be found in the 'Scanner Settings' section of this guide.

 1.7.3 How to Quickly Set up Security Levels
Comodo Antivirus allows users to quickly view or change the current security level by right clicking on the system tray icon:
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To set the Real time Scanning level for Antivirus
• Right click on the system tray icon
• Move the mouse cursor over Antivirus Security Level

The available security levels are:

• On Access - Every file will be scanned every time a file opened. Highest protection but may make the AV too 'busy' for 
many users

• Stateful (default and recommended) - When a file is opened, CAV will only scan it if it has not been scanned since the 
last virus database update. This is an ideal mix of security and usability

• Disabled - Not recommended. Files are not virus-scanned when they are opened, strongly raising the possibility that 
your system could get infected.

The currently active configuration is displayed with a checkmark next to it. For more details on these settings refer to Scanner 
Settings > Real Time Scanning.

You can also access these settings through the CAV summary screen. In the example below, the security level is 'Stateful'. 
Click the word to access the settings described on this page.
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 1.7.4 How to Password Protect Your CAV Settings
This page explains how to password protect access to the CAV interface. Implementing the steps explained on this page means 
another user will not be able to access the CAV interface to modify or over-ride the security settings you have implemented.

Click here for more details on parental control settings.

To enable password protection
• Click the ‘More’ button along the top navigation
• Click 'Preferences' in 'More' menu
• Click on 'Parental Control' tab

• Select 'Enable password protection for the settings' checkbox to activate password protection
• Click 'Change Password'
• In the 'Change Password' dialog, type a password and retype the password in the respective text boxes
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• Click 'Apply'.

Enabling password protection will secure all of your important CAV settings and configurations. After setting a password, users 
will be asked for this password every time they try to access important configuration of the Antivirus Tasks areas.

Suppressing alerts whilst under password protection
When you select the 'Enable password protection for the settings' checkbox the following Suppress Antivirus alerts when 
password protection is enabled.

Selecting this option will suppress Antivirus alerts as well as automatically blocking the requested action. This is useful because 
it avoids the situation wherein an inexperienced user clicking ‘Allow’ simply to dismiss an alert (and inadvertently allowing a 
malicious action to proceed).
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Select the component(s) that you want to suppress the alerts and click 'OK'

If you choose to suppress alerts, you must remember to de-suppress them next time you log on. If you don't, then CAV will 
continue to silently block certain actions without notification.

Important Notes:
Due to the fact that this configuration suppresses and blocks all alerts, certain software updates may be unable to run in this 
mode.  A good idea is to create a preset configuration (called ''Updater Configuration" for example), and configure it to allow all 
of your updaters to install smoothly. This way, when switching to this configuration, you can perform maintenance on your 
computer, and afterward, switch it back to the parental configuration (which suppresses all alerts) so no one else can make 
changes. This method would prove very useful for tasks such as Microsoft Windows service pack updates, to ensure a proper 
installation is performed. Refer to 'Manage My Configurations' to know more about preset configurations.

 1.7.5 How to Run an Instant Antivirus Scan on Selected Items
You can instantly virus scan virtually any file, folder, photo, application or hard-drive by simply dragging the item into the scan 
box on the summary screen or onto the Comodo icon on the dock.

To scan selected item(s):
Drag the item(s) into the scan box in the summary screen of the CAV interface. If the CAV is not running, drag the item(s) on to 
the Comodo icon on the dock. 

Before running the scan, Comodo Antivirus will first check for AV database updates. If updates are available they will be 
downloaded and installed:
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Scanning will commence immediately after the updates are installed. 

On scan completion, the results screen will list the name and risk level of all threats found.

Click here for help on how to react if infected item(s) are found.

 1.7.6 How to Create a Scheduled Scan
Comodo Antivirus allows you to schedule Antivirus scans on your entire system or on specific areas according to your 
preferences.

To create an antivirus scanning schedule
• Click the 'Antivirus' button along the top navigation
• Click 'Scheduled Scans' in the Antivirus menu
• Click the 'Add' button to begin creating your schedule
• Type a name for your schedule in the text box
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• Select a scanning profile from the Profile drop-down menu. (Selecting a scanning profile will define the areas in your 
computer to be scanned during this schedule. For more details on Scanning profiles, refer to Antivirus Tasks > Scan 
Profiles)

• Select the day(s) (Monday to Sunday) when you want the scan(s) to be run
• Select the time of the day when the scheduled scan is to be started
• Click 'Apply'.

Your new scan schedule will be listed in the 'Scheduled Scans' interface. You can modify or remove it at any time by clicking the 
'Edit...' or Remove button.
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Repeat the process to add new scan schedules.

For more details on the Scheduled Scans, refer to Antivirus Tasks > Scheduled Scans.

 1.7.7 How to Restore Incorrectly Quarantined Item(s)
If you have incorrectly quarantined item(s) or you feel an item has been incorrectly quarantined by the application (a false 
positive) then you can restore it/them using the following procedure:

• Click the ‘Antivirus’ button from the top navigation and click 'Quarantined Items' in the ‘Antivirus Tasks interface
• Select the items you wish to restore from the 'Quarantined Items'. For selecting multiple items, press and hold down 

the Ctrl key.
• Click 'Restore' to begin restoring the item(s).
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All the selected files will be restored to their original locations immediately.

• Click 'Close' button to exit.
Click here for more details on the Quarantined Items. 

 1.7.8 How to Submit Quarantined Items to Comodo for Analysis
Items which have been quarantined as a result of an On Access, On Demand or Scheduled Scans, can be sent to Comodo for 
analysis. After the analysis, if the submitted item is found to be a False Positive, it will be added to the Comodo Safe List. 
Conversely, if it is found to be a malware, it will be added to the anti-malware Black list. This helps Comodo to enhance its virus 
signature database and helps benefit millions of other CAV users.

Click here for more details on Quarantined Items.

To submit quarantined items
• Click the ‘Antivirus’ button from the top navigation then click 'Quarantined Items'
• Select the items you wish to submit for analysis from the 'Quarantined Items' interface. to select multiple items, press 

and hold down the Ctrl key.
• Click 'Submit'
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The submission progress will be indicated:

On completion, the submission results will be displayed, indicating whether the file is successfully submitted or already 
submitted by other users and is pending analysis.
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 1.7.9 How to Switch off Automatic Software and Antivirus Updates
By default, Comodo Antivirus will automatically check for software and Antivirus database updates. However, some users like to 
have control over what gets downloaded and when it gets downloaded. For example, network administrators may not wish to 
automatically download because it will take up to much bandwidth during the day. Similarly, users that have particularly heavy 
traffic loads may not want automatic updates because they conflict with their other download/upload activity.

CAV provides full control over virus and software updates. Click the appropriate link below to find out more:

• Switch off automatic software updates
• Switch off automatic virus updates

To switch off automatic software updates:
• Click the 'More' button from the top navigation and click 'Preferences' link from the 'More' Tasks interface.
• Click 'General' tab from the 'Preferences' interface.
• Deselect the check box 'Automatically check for program updates'.
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• Click 'Ok'.
To switch off automatic Antivirus database updates:
Automatic virus updates can be completely switched off, or can be switched off for individual scans. Click the link appropriate to 
your requirements:

• Switch off automatic virus updates
• Switch off updates prior to a Manual Scan
• Switch off updates prior to a Scheduled scan

To Switch off automatic virus database updates 
• Click the 'Antivirus' button from the top navigation and click 'Scanner Settings' from the Antivirus Tasks interface.
• Click the 'Real Time Scanning' tab from the 'Scanner Settings' interface.
• Deselect the checkbox 'Automatically update virus database'.
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• Click 'OK'.
The check and download of automatic Antivirus database updates executed during every system start-up and at regular intervals 
will be stopped.

To switch off virus database updates prior to a Manual Scan
• Click the 'Antivirus' button from the top navigation and click 'Scanner Settings' from the Antivirus Tasks interface.
• Click the 'Manual Scanning' tab from the 'Scanner Settings' interface.
• Deselect the checkbox 'Automatically update the virus database before scanning'.
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• Click 'OK'.
The check and download of automatic Antivirus database updates executed before every on-demand or manual scanning will be 
stopped.

To switch off virus database updates prior to a Scheduled Scan
• Click the 'Antivirus' button from the top navigation and click 'Scanner Settings' from the Antivirus Tasks interface.
• Click the ' Scheduled Scanning' tab from the 'Scanner Settings' interface.
• Deselect the checkbox 'Automatically update the virus database before scanning'.
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• Click 'OK'.
The check and download of automatic Antivirus database updates executed before commencement of every scheduled 
scanning will be stopped. 

 1.7.10 How to Temporarily Suppress Alerts while Playing a Game
Placing CAV in 'Game Mode' will temporarily disable alerts from appearing. Scheduled virus scans and database updates are 
also postponed until this mode is disabled.

Note: Antivirus protection is still active and your protection is not impacted by 'Game Mode'. All that happens is that alerts will 
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not be generated so your game is not interrupted. 

To enable game mode
• Right click on the CAV System Tray icon.

• Select 'Game Mode' from the options.

The alerts are now suppressed. Scheduled scans and virus database updates will not resume until this mode is de-activated. 

 1.7.11 How to View Antivirus Reports
The ‘View AntiVirus Events’ module contains extensive logs of all actions taken by the virus scanner. The basic event viewer will 
tell you the date and time a particular virus was detected, where it was located and the action that was taken to deal with it. The 
advanced event viewer allows you to filter events, export logs and to view other types of event logs (‘alerts displayed’, ‘tasks 
launched’ and ‘configuration changes’).

To view Antivirus Events
• Click the ‘Antivirus Button’
• Click 'View Antivirus Events'

The basic event viewer displays the date, time and status of each antivirus event.
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• Click the ‘More…’ button to open the advanced event viewer
• The event viewer is described in more detail on the 'View Antivirus Events' section.
• To configure the maximum size of a log file, see 'Log Settings' in 'Preferences'. 
• To disable Antivirus logging,  see ‘Log Settings’ in ‘Preferences’.

 2 Antivirus Tasks - Introduction
The Antivirus Task Center allows you to run custom, on-demand virus scans and to configure how you want the antivirus 
scanner to behave.

This area also allows you to alter scan settings for each scan type and to use the fully featured scheduler to run scans according 
to a time table of your choice. Other features include the ability to create custom scan profiles, view/export event logs, specify 
update settings, submit files for analysis and to view any quarantined files.

The Antivirus tasks center can be accessed at all times by clicking the 'Antivirus' tab. 
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Click the links below to see detailed explanations of each area in this section. 

• Run a Scan
• Update Virus Database
• Quarantined Items
• View Antivirus Events
• Submit Files
• Scheduled Scans
• Scan Profiles
• Scanner Settings

 2.1 Run a Scan
The 'Run a Scan' area allows you to launch an On-Demand Scan on an item of your choice. The item can be anything you 
choose – your entire computer, a specific drive or partition or even a single file. You can also choose to scan a wide range of 
removable storage devices such as CD's, DVD's, external hard-drives, USB connected drives, digital cameras and more. 
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You have two options available when you choose to run an On-Demand Scan:

1 . Scan a preselected area.

2 . Define a custom scan of the areas you choose.

Scanning Preselected Areas
Comodo Antivirus has two pre-defined scan profiles - 'My Computer' and 'Critical Areas'. These cannot be edited or removed. 
They are: 

i. My Computer (Default)  - When this Profile is selected, Comodo Antivirus scans every local drive, folder and file 
on your system.

ii. Critical Areas - When this profile is selected, Comodo Antivirus runs a targeted scan of important operating 
system files and folders.

To run one of these profiles, simply highlight it from the list and click 'Scan' (or just double-click the profile name). 
Custom Scan
To run a scan on a particular item of your choosing, you first need to create a scan profile. To do this:

• Click the 'Create New Scan' button
• Type a name for your new profile in the 'Scan Profile' dialog (for example, 'My External Drives')
• Click the 'Add' button to choose the files, folders or drives you wish to include in the scan profile. You can select 

multiple items
• Click 'Apply' to return to the 'Scan Profile' dialog then 'Apply' again. Your new profile will be listed in the 'Run a 

Scan' dialog (see  Create a Scan Profile i f  you ne ed  mor e  he l p  wi th  t h i s ) .  

• Select your new profile in the list and click 'Scan'
• Your scan will begin. Next, see: 

• Scan progress and results
• The results window
• Saving results as a text file
• Moving threats to quarantine
• Disinfecting/deleting threats
• Ignore a result once / Ignore and report as false positive / Ignore and create an exception  
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Tip: If you just want to run a quick scan on a file or folder, you can just drag it into the scan box in the 'Summary' area or, if the 
interface is not open, by drag it onto the Comodo dock icon.

Tip: For more details on Scan profiles, refer to Antivirus Tasks > Scan Profiles.

S c an prog r e s s  and r e s u l t s

Before running the scan, Comodo Antivirus will first check for AV database updates. If updates are available they will be 
downloaded and installed.

The scan, based on the profile you selected, will begin immediately after updates have been installed. The progress dialog 
displays the profile name, the location that is currently being scanned, the start time and duration of the scan, the total number of 
objects scanned so far and the number of threats found.

Clicking the 'Pause' button will suspend the scan until such time that you click 'Resume'. Click 'Stop Scan' to abort the scan 
process altogether.

Once the scan is complete, the results window will open: 

The Re su l t s  Window

On scan completion, the results screen will list the name and risk level of all threats found:

Comodo Antivirus 2011 User Guide | © 2014 Comodo Security Solutions Inc. | All rights reserved                                                     39



Com o d o  An t i v i r u s  -  Us e r  Gu i d e

You can sort the scan results by alphabetical order by clicking the 'Threat Name' column header. Similarly you can sort the scan 
results based on the risk level by clicking the 'Risk' column header. To select all the entries for actions such as moving them to 
quarantine or disinfect, select the check box beside the 'Threat name'. 

To s a v e  t h e  S c an Re su l t s  a s  a  Tex t  F i l e

1 . Click 'Save' and enter the location in the 'Save' dialog box. 

To move s e l e c t ed t h r e a t s  t o  Qua r an t i n ed I t em s

1. Select the application from the results, click the drop-down button beside 'Clean' and select 'Quarantine'.
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2 . Click 'Yes' at the confirmation dialog box. 

The selected application is moved to the Quarantined items section. For more details on quarantined applications, refer to 
Antivirus Tasks > Quarantined Items. 

To d i s i n f e c t  a  f i l e  o r  app l i c a t i on 

1. Select the applications from the results, click the drop-down button beside the 'Clean' button and choose 'Disinfect'. 
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2. Click 'Yes' at the confirmation dialog box. 

The Antivirus disinfects the file if a disinfection routine exists. The file will be returned to its pre-viral state. If no disinfection 
routine is available, the file is deleted permanently from your system. 

To i g no r e  an app l i c a t i on / f i l e  you con s i d e r  a s  s a f e  f r om t h e  t h r e a t  
l i s t  

• Click the 'Ignore' button
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Selecting 'Ignore' provides you with three options.

• Once - If you click 'Once', the virus is ignored only at that time only. If the same application invokes again, an 
alert will be displayed.

• Report this to COMODO as a False Alert – If you are sure that the file is safe, select 'Report this to Comodo as 
False Alert'. This will submit the file to Comodo for analysis. If the file is found to be trustworthy, it will be added to 
the Comodo white-list.

• Add to Exclusions -  If you click 'Add to Exclusions', the virus is moved to Exclusions list. The alert is not 
generated if the same application invokes again. 

Creating a Scan profile

Scan Profiles are the user-defined profiles containing specific areas on your system that you wish to scan and can be re-used 
for all future scans.

To c r e a t e  a  new s c an pro f i l e

• Click 'Create New Scan' in the 'Run a Scan' interface. 

A 'Scan Profile' configuration appears. 
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• Type a name for the scan profile to be created in the 'Name' box. 
• Click 'Add'.

A configuration screen appears, prompting you to select the locations to be scanned when the newly created scan profile is 
selected.

• Select the locations from the left column, drag and drop to the right column or select the locations and click right 
arrow to move selected folders to right column. 

• Click 'Apply'.
• Repeat the process to create more Scan Profiles. 

Note: You can also create new Scan Profiles by accessing Scan Profiles in the Antivirus Screen.
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I n s t an t l y  S c an Ob j e c t s  

You can instantly virus scan virtually any file, folder, photo, application or hard-drive by simply dragging the item into the scan 
box on the summary screen or onto the Comodo icon on the dock. 

 2.2 Update Virus Database
In order to guarantee the continuing effectiveness of your antivirus software, it is imperative that your virus databases are 
updated as regularly as possible.

Our anti-virus database is maintained and updated around the clock by a team of dedicated technicians, providing you with the 
solutions to the latest virus outbreaks. Updates can be downloaded to your system manually or automatically from Comodo's 
update servers.

To manua l l y  che ck f o r  t h e  l a t e s t  v i r u s  Da t ab a s e  and t h en down lo ad t h e  
upda t e s

1 . Click on the 'Update Virus Database' from the main Antivirus Task Manager Screen. 

Note: You must be connected to Internet to download the updates.

A dialog box appears, showing you the progress of update process.
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You will see the following notification when the update process is complete:

When infected or possibly infected files are found, if the anti-virus database has been not updated for a critically long time, or 
your computer has not been scanned for a long time, the main window of Comodo Antivirus recommends a course of action and 
gives a supporting explanation.

Automatic Updates
By default, Comodo Antivirus is set to automatically check for and download updates from the Comodo servers before 
commencing a scan of any type. You can configure whether these automatic checks updates take place on a 'per scanner' basis 
in 'Scanner Settings. Refer to Real Time Scanning Settings and Scheduled Scanning Settings for more details. 'Manual 
Scanning' refers to 'on demand' scans carried out on items when, for instance, they are dragged in the scan box or the Comodo 
dock icon.

 2.3 Quarantined Items
The quarantine facility removes and isolates suspicious files into a safe location before analyzing them for possible infection. 
Any files transferred in this fashion are encrypted- meaning they cannot be run or executed. This isolation prevents infected files 
from affecting the rest of your computer. If a file cannot be disinfected, then it provides a reliable safe-house until the virus 
database is updated- neutralizing the impact of any new virus.

For adding executables to Quarantined items, refer to Antivirus Tasks > Run a Scan. You can also:

• Manually add applications, executables or other files, that you do not trust, as a Quarantined item 
• Delete a selected quarantined item from the system
• Restore a quarantined item
• Delete all quarantined items 
• Submit selected quarantined items to Comodo for analysis

To v i ew t h e  l i s t  o f  Qua r an t i n ed I t em s

• Click 'Quarantined Items' from the main Antivirus Task Manager Screen.
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Column Descriptions
• Item - Indicates which application or process propagated the event;
• Location - Indicates the location where the application or the file is stored;
• Date/Time - Indicates date and time, when the item is moved to quarantine.

Manually adding files as Quarantined Items
If you have a file, folder or drive that you suspect may contain a virus and not been detected by the scanner, then you have the 
option to isolate that item in quarantine.

To manua l l y  add a  Qua r an t i n ed I t em

• Click Add and select the file from Open dialog box. 
To de l e t e  a  qua r an t i n ed i t em f r om t h e  s y s t em

• Select the item and Click 'Delete'. 
This deletes the file from the system permanently.

To r e s t o r e  a  qua r an t i n ed i t em t o  i t s  o r i g i n a l  l o c a t i on

• Select the item and click 'Restore'. 
If the restored item does not contain a malware, it operates as usual. But if it contains a malware, it is detected as a t h r e a t  
immediately, if the Real Time Scanning is enabled or during the next scan.

To r emove  a l l  t h e  qua r an t i n ed i t em s  pe rmanen t l y

• Click 'Clear'. 
This deletes all the quarantined items from the system permanently.

To s ubm i t  s e l e c t ed qua r an t i n ed i t em s  t o  Comodo f o r  an a l y s i s

• Select the item from the list and click 'Submit'. 

Note: Quarantined files are stored using a special format and do not constitute any danger to your computer.
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 2.4 View Antivirus Events
Comodo Antivirus documents the results of all actions performed by it in extensive but easy to understand reports. A detailed 
scan report contains statistics of all scanned objects, settings used for each task and the history of actions performed on each 
individual file. Reports are also generated during real-time protection, and after updating the anti-virus database and application 
modules.

To v i ew a  l o g  o f  An t i v i r u s  Even t s

• Click 'View Antivirus Events' from the main Antivirus Task Manager Screen. 

Column Descriptions
• Location - Indicates the location where the application detected with a threat is stored.
• Malware Name - Name of the malware event that has been detected.
• Action - Indicates action taken against the malware through Antivirus.
• Status - Gives the status of the action taken. It can be either 'Success' or 'Fail'.
• Date - Indicates the date of the event.

Click 'More' to load the full Comodo Antivirus Log Viewer module. 

This window contains a full history of logged events in two categories: Logs per Module and Other Logs. 

It also allows you to build custom log files based on specific filters and to export log files for archiving or troubleshooting 
purposes.
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The Log Viewer Module is divided into three sections. The top panel displays a set of handy, predefined time Filters. The left 
panel the types of Logs. The right hand side panel displays the actual events that were logged for the time period you selected 
in the top panel and the type of log selected in the left panel (or the events that correspond to the filtering criteria you selected).

 The Logs per Module option contains the logged event Antivirus module and Other Logs options contains logged events of the 
following:

• Alerts Displayed: Displays the list of various alerts that were displayed to the user, the response given by the user to 
those alerts and other related details of the alert. 

• Tasks Launched: Displays the various Antivirus tasks such as updates and scans that have taken place. This area will 
contain a log of all on demand and scheduled AV scans and the result of that scan. 

• Configuration Changes: Displays a log of all configuration changes made by the user in the CAV application. 

  
Filtering Log Files
Comodo Antivirus allows you to create custom views of all logged events according to user defined criteria.

Preset Time Filters:
Clicking on any of the preset filters in the top panel alters the display in the right hand panel in the following ways:

• Today - Displays all logged events for today.
• Current Week - Displays all logged events during the current week. (The current week is calculated from the 

Sunday to Saturday that holds the current date.)
• Current Month - Displays all logged events during the month that holds the current date.
• Entire Period - Displays every event logged since Comodo Antivirus was installed. (If you have cleared the log 

history since installation, this option shows all logs created since that clearance).
The example below shows an example display when the Antivirus Events for 'Today' are displayed.
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User Defined Filters:

Having chosen a preset time filter from the top panel, you can further refine the displayed events according to specific filters. 
The table below provides a summary of available filters and their meanings:

Available Filters - Logs per Module

Filter Option Description

 Action Displays events according to the response (or action taken) by 
the Antivirus.

Date Indicates the date of events.

Location Displays only the events logged from a specific location.

Status Displays the events according to the status after the action 
taken. It can be either 'Success' or 'Fail'.

Malware Name Displays only the events logged corresponding to a specific 
malware. 

Alert Displays alert notifications.

Creating Custom Filters
Custom Filters can be created through the 'Advanced Filter' interface. If it is not already visible, you can open the 'Advanced 
Filter' bar by right-clicking on the interface and selecting 'Advanced Filter'.

• Right click on any event and select 'Advanced Filter' option to open the corresponding configuration area.
The 'Advanced Filter' configuration area is displayed in the top half of the interface whilst the lower half displays the Events, 
Alerts, Tasks or Configuration Changes that the user has selected from the upper left pane. If you wish to view and filter event 
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logs for other modules then simply click log name in the tree on the upper left hand pane.

This section will deal with Advanced Event Filters related to 'Antivirus Events' and will also cover the custom filtering that can be 
applied to the 'Other Logs' (namely 'Alerts Displayed', 'Tasks' Launched' and 'Configuration Changes'). 

Antivirus Events - Advanced Filters

To con f i gu r e  Advanc ed F i l t e r s  f o r  An t i v i r u s  e v en t s

1 . Select 'View > Advanced Filter'

2 . Select 'Antivirus Events' under 'Logs Per Module'

You have 4 categories of filter that you can add. Each of these categories can be further refined by either selecting or 
deselecting specific filter parameters or by the user typing a filter string in the field provided.

3 . C l i c k  t h e  ' A dd '  bu t t on  when you hav e  cho s en  t h e  c a t e go r y  upon wh i ch  you wi sh t o  
f i l t e r .  

Following are the options available in the 'Add' drop-down:

i. Action: Selecting the 'Action' option displays a drop down field and a set of specific filter parameters that can be 
selected or deselected.

a ) Select 'Equal' or 'Not Equal' option from the drop down. 'Not Equal' will invert your selected choice. 
b ) Now select the checkboxes of the specific filter parameters to refine your search. The parameter available are:
• Quarantine: Displays events where the user chose to quarantine a file 
• Remove: Displays events where the user chose to delete an item 
• Ignore: Displays events where the user chose to ignore an item 
• Detect: Displays events for detection of a malware 
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• Ask: Displays events when user was asked by alert concerning Antivirus event 
• Restore: Displays events of the applications that were quarantined and restored.

The filtered entries are shown directly underneath.

For example, if you checked the 'Quarantine' box then selected 'Not Equal', you would see only those Events where 
the Quarantine Action was not selected at the virus notification alert.  

ii. Location: Selecting the 'Location' option displays a drop-down field and text entry field.

a ) Select 'Contains' or 'Does Not Contain' option from the drop-down field.
b ) Enter the text or word that needs to be filtered.

The filtered entries are shown directly underneath.

For example, if you select 'Contains' option from the drop-down field and enter the word 'unclassifiedMalware' in the 
text field, then all events containing the word 'unclassifiedMalware' in the Location field will be displayed directly 
underneath. If you select 'Does Not Contain' option from the drop-down field and enter the word 'System' in the text 
field, then all events that do not have the word 'System' will be displayed directly underneath. 

iii. Malware Name: Selecting the 'Malware' option displays a drop-down field and text entry field.

a ) Select 'Contains' or 'Does Not Contain' option from the drop-down field.
b ) Enter the text or word that needs to be filtered.

The filtered entries are shown directly underneath.

Refer to the example given for 'Location' option for better understanding.

iv. Status: Selecting the 'Status' option displays a drop-down field and a set of specific filter parameters that can be 
selected or deselected.

a ) Select 'Equal' or 'Not Equal' option from the drop-down field. 'Not Equal' will invert your selected choice. 
b ) Now select the checkboxes of the specific filter parameters to refine your search. The parameter available are:

• Success: Displays Events that successfully executed (for example, the 
database was successfully updated) 

• Failure: Displays Events that failed to execute (for example, the database 
failure to update correctly) 

The filtered entries are shown directly underneath.

Refer to the example given for 'Action' option for better understanding.

Note: More than one filters can be added in the 'Advanced Filter' pane. After adding one filter type, the option to select the next 
filter type automatically appears. You can also remove a filter type by clicking the 'Remove' option at the end of every filter 
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option. 

Other Logs - Advanced Filters

To con f i gu r e  Advanc ed F i l t e r s  f o r  A l e r t s  Di sp l a y ed

1 . Select 'View > Advanced Filter'.

2 . Under 'Other Logs', select 'Alerts Displayed'.

This will open the Advanced Filter pane to the upper right. From here, you can chose the category of filter from a drop-
down box. Each of these categories can be further refined by either selecting or deselecting specific filter parameters 
or by the user typing a filter string in the field provided.

3 . Click  'Add' when you have chosen the category upon which you wish to filter.

The following table lists the various filter categories and parameters for 'Alerts Displayed'.

Available Filters - Other Logs - Alerts Displayed

Filter Option Description 

Type Displays the type of alert

Description Displays the name of the event

Advice Suggests an advice that can be executed by the user for that event

Answered Displays the date and time on which the alert was answered
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Available Filters - Other Logs - Alerts Displayed

Flags Filters the events based on the flags set for them

Answer Displays the answer that was given by you for the alert 

Treat As Displays the type of policy, if any, for the corresponding event type 

To con f i gu r e  Advanc ed F i l t e r s  f o r  Ta sk s  L aunched

1 . Select 'View > Advanced Filter'.

2 . Under 'Other Logs', select 'Tasks Launched'.

This will open the Advanced Filter pane to the upper right. From here, you can chose the category of filter from a drop-
down box. Each of these categories can be further refined by either selecting or deselecting specific filter parameters 
or by the user typing a filter string in the field provided.

3 . Click 'Add' when you have chosen the category upon which you wish to filter.

The following table lists the various filter categories and parameters for 'Tasks Launched'.

Available Filters - Other Logs - Tasks Launched

F i l t e r  Op t i on De s c r i p t i on 

Type Displays the type of task. It can be an antivirus update or scan type. 

Parameter Displays the name of the scan profile. This column is populated only if 'Av Scan' option is 
displayed in 'Type' column.

Comodo Antivirus 2011 User Guide | © 2014 Comodo Security Solutions Inc. | All rights reserved                                                     54



Com o d o  An t i v i r u s  -  Us e r  Gu i d e

Available Filters - Other Logs - Tasks Launched

Completed Displays the date and time at which the task was executed.

Code Displays a code value if the task was not performed successfully and for task updates it shows a 
standard value: 0x00000001 if base is up to date

To con f i gu r e  Advanc ed F i l t e r s  f o r  ' Con f i gu r a t i on Change s '

1 . Select 'View' > 'Advanced Filter'

2 . Under 'Other Logs', select 'Configuration Changes'

This will open the Advanced Filter pane to the upper right. From here, you can chose the category of filter from a drop-
down box. Each of these categories can be further refined by either selecting or deselecting specific filter parameters 
or by the user typing a filter string in the field provided.

3 . Click 'Add' when you have chosen the category upon which you wish to filter.

The following table lists the various filter categories and parameters for 'Configuration Changes'.

Available Filters - Other Logs - Configuration Changes

F i l t e r  Op t i on De s c r i p t i on 

Action Displays events according to the response (or action taken) by the Antivirus. 

Modifier Displays events sorted based on whether the configuration was changed by the User. It could also 
be a Auto learn or Execution alert. 
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Available Filters - Other Logs - Configuration Changes

Object Displays the object for which the configuration change took place. 

Name Displays the name of the configuration entry, if it can be determined.

Date Filter
The Date Filter can be seen in the lower left hand pane. Using the Date Filter you can easily see the events on a particular date 
or on a date range. 

To v i ew t h e  e v en t s  on a  pa r t i c u l a r  da t e

1. Click the right arrow or the left arrow to select the required month and year.

2. Now, click the required date. The events on that particular date is displayed. 
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To v i ew t h e  e v en t s  on a  da t e  r ange  

• Click the date and it's events, according to the filters selected, are shown in the main pane. 
  

Click 'View'  in the menu bar  -> 'Period' and choose the date events. This is a toggle command and you can repeat this step to 
make the Date Filter appear. 

Exporting Log Files to HTML
Exporting log files is useful for archiving and troubleshooting purposes.  After making your choice and setting the filters. the log 
displayed can be directly exported as HTML file. There are two ways to export log files in the Log Viewer interface - using the 
context sensitive menu and via the 'File' menu option. 

i. File Menu
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1 . Select the event for which the log report is to be taken.

2 . Click 'Export' from the File menu.

3 . Select the location where the log report has to be saved, provide a file name and click 'Save'.

ii. Context Sensitive Menu

1 . R igh t  c l i c k  i n  t h e  l o g  d i s p l a y  window t o  expo r t  t h e  cu r r en t l y  d i s p l a y ed  
l o g  f i l e  t o  HTML .

You can export a custom view that you created using the available Filters by right clicking and selecting 'Export' from the context 
sensitive menu.

Again, you are asked to provide a file name and save location for the file.

 2.5 Submit Files to Comodo for Analysis
Files which are not in the Comodo safe list and are also unknown to the user can be submitted directly to Comodo for analysis 
and possible addition to the safe list. 

You can submit the files which you suspect to be a malware or the files which you consider as safe but identified as malware by 
Comodo Antivirus (False Positives). The files are analyzed by experts in Comodo and added to white list or black list 
accordingly. 

To s ubm i t  f i l e s  t o  Comodo

1 . Click on the 'Submit Files' link from t h e  main Antivirus Task Manager screen. The Browser dialog opens.
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2 . Select the items (files or folders) you wish to submit to Comodo for analysis from the right hand pane and move them 
to right hand pane by clicking the right arrow one by one. (If you want to revert a file, select the file f r om the right 
hand pane and click the left arrow)

3 . Click 'Submit As' and select :

• 'False-Positive' for files you consider to be safe 
or

• 'Suspicious' for files you suspect to be malware from the submit options.

Progress bars indicate the progress of the files submission to Comodo.
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When a file is first submitted, Comodo's online file look-up service will check whether the file is already queued for analysis by 
our technicians. The results screen displays these results: 

'Successfully submitted' - The file's signature was not found in the list of files that are waiting to be tested and was therefore 
uploaded from your machine to our research labs.

• 'Already submitted' - The file has already been submitted to our labs by another Antivirus user and was not uploaded 
from your machine at this time. 

Comodo will analyze all submitted files. If they are found to be trustworthy, they will be added to the Comodo safe list (i.e. white-
listed). Conversely, if they are found to be malicious then they will be added to the database of virus signatures (i.e. black-listed).

 2.6 Scheduled Scans
Comodo Antivirus features a highly customizable scheduler that lets you timetable scans according to your preferences. 
Comodo Antivirus automatically starts scanning the entire system or the disks or folders contained in the profile selected for that 
scan.

You can add an unlimited number of scheduled scans to run at a time that suits your preference. A scheduled scan may contain 
any profile of your choice.

You can choose to run scans at a certain time on a daily, weekly, monthly or custom interval basis. You can also choose which 
specific files, folders or drives are included in that scan.

Comodo Antivirus gives you the power to choose, allowing you to get on with more important matters with complete peace of 
mind.
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From the 'Scheduled Scans' panel, you can

• Set a new scheduled scan
• Edit a pre-scheduled scan 
• Cancel a pre-scheduled scan

The detection settings for the Scheduled Scans can be configured under the Scheduled Scanning tab of the Scanner Settings 
interface.

To s e t  a  S chedu l ed S c an

1 . Click on the Scheduled Scans link in the main Antivirus Task Manager screen.

A default schedule 'Weekly Virus Scanning' is displayed. This schedule is set so that your computer is scanned on every Sunday 
at 12:00am. You can edit this schedule by selecting it and clicking the 'Edit' button.

2 . Click 'Add'. The 'Scan Schedule' panel opens.
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3 . Type a name for the newly scheduled scan in the 'Name' box. 

4 . Select a scanning profile from the list of preset scanning profiles by clicking at the drop-down arrow, in the 'Profile' box. 
(For more details on creating a custom Scan Profile that can be selected in a scheduled scan, see Antivirus Tasks > 
Scan Profiles.

5 . Select the days of the week you wish to schedule the scanning from 'Days of the Week' check boxes. 

6 . Set the starting time for the scan in the selected days in the 'Start time' drop-down boxes. 

7 . Click 'Apply'. 

8 . Repeat the process to schedule other scans with o t h e r  predefined scan profiles. 

To ed i t  a  S chedu l ed S c an

1 . Select the schedule from the list. 

2 . Click 'Edit' in the 'Scheduled Scans' setting panel. 

3 . Edit the necessary fields in the 'Scan Schedule' panel. 

4 . Click 'Apply'. 

To c anc e l  a  pr e - s c h edu l ed s c an

1 . Select the Scan Schedule you wish to cancel in the 'Scheduled Scans' settings panel.

2 . Click 'Remove'. 

 2.7 Scan Profiles
Creating a Scan Profile allows you to instruct Comodo Antivirus scan selected areas, folders or selected drives of your system. 
You will be asked to select a profile whenever you click the 'Scan Now' link on the Summary Screen.

 You can create custom scan profiles, to define selected disks or folders to be scanned and the created scan profile can be re-
used for any desired scan event i.e. Run a Scan (On-Demand Scanning) and Scheduled Scans. You can create as many 
number of custom scan profiles as you wish according to the usage of your system. A Scan Profile allows you to scan only a 
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selected area of your storage, saving time and resources.

• New scan profiles can be created by clicking the

•  'Create New Scan' button in the 'Run a Scan' panel or by clicking the 'Add button' in the 'Scan Profiles' area.
• New scan profiles can then be referenced when creating a new 'Scheduled Scan' and as the target of an on-

demand scan in the 'Run a scan' area.
Just to clarify, AntiVirus scan profiles are purely concerned with the location of a scan, not the parameters of the scan. All scan 
profiles use the parameters as determined in the specific 'Scanner Settings' tab of that type of scan.

To a c c e s s  t h e  S c an P ro f i l e s  i n t e r f a c e

• Click 'Scan Profiles' from the main Antivirus Tasks Manager Screen. 

Comodo Antivirus contains two default Scan Profiles 'My Computer' and 'Critical Areas'. These two profiles are predefined and 
cannot be edited or removed.

• My Computer (Default) - When t h i s  P r o f i l e  i s  s e l e c t e d ,  Comodo An t i v i r u s  s c an s  
e v e r y  l o c a l  d r i v e ,  f o l d e r  and f i l e  on you r  s y s t em .  

• Critical Areas - When t h i s  p r o f i l e  i s  s e l e c t e d ,  Comodo An t i v i r u s  r un s  a  t a r g e t e d  
s c an o f  impo r t an t  op e r a t i ng  s y s t em f i l e s  and f o l d e r s  .

You can select any one of these Scan Profiles if you want to scan the respective areas.

To c r e a t e  a  new s c an pro f i l e  f r om S c an P ro f i l e s  op t i on

1 . Click 'Scan Profiles' from the main Antivirus Tasks Manager Screen. 

2 . Click 'Add'. The 'Scan Profile' dialog appears. 

3 . Type a name for the scan profile to be created in the 'Name' box and click 'Add'. 
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A configuration screen appears, prompting you to select the locations to be scanned when the newly created scan profile is 
selected. The left column displays all possible items (drives, folders and files) on your system for which scanning is available.

4 . Browse to the folder location in the left column and select the folder. 

5 . Drag and drop all the files, folders and/or drives you require, into the right hand panel or select the files or folders and 
move them to right-hand pane by clicking the right arrow one by one. (If you want to revert a file, select the file from 
the right hand pane and click the left arrow).

6 . Click 'Apply'. 

7 . Repeat the process to create more Scan Profiles. 

8 . Click 'Apply' in the Scan Profiles interface for the created profiles to take effect. 

You can see that the Scan Profile you have created, appearing as a target profile in the 'Run a Scan' panel...
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...it is also available for selection during a scheduled scan in the drop-down.

• To edit a Scan Profile, select the profile and click 'Edit'.
• To delete a Scan Profile, select the profile and click 'Remove'. 

 2.8 Scanner Settings
The Settings configuration panel allows you to customize various options related to Real Time Scanning (On-Access Scanning), 
Manual Scanning, Scheduled Scanning and Exclusions (a list containing the files you considered safe and ignored the alert 
during a virus scan).

• The settings made for each type of the scan applies to all future scans of that type.
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• All items listed and all items added to the 'Exclusions' list is excluded from all future scans of all types. 
To open V i r u s  S c anne r  S e t t i n g s  pane l

• Click on 'Scanner Settings' link in the main Antivirus Tasks Management Screen.

The options that can be configured using the settings panel are

• Real Time Scanning - To set the parameters for on-access scanning; 
• Manual Scanning - To set the parameters for manual Scanning (Run a Scan); 
• Scheduled Scanning - To set the parameters for scheduled scanning; 
• Exclusions - To see the list of ignored threats and to set the parameters for Exclusions. 

 2.8.1 Real Time Scanning 
The Real time Scanning (aka 'On-Access Scanning') is always ON and checks files in real time when they are created, opened 
or copied. (as soon as you interact with a file, Comodo Antivirus checks it). This instant detection of viruses assures you that 
your system is perpetually monitored for malware and enjoys the highest level of protection. You also have options to 
automatically remove the threats found during scanning and to update virus database before scanning. It is highly recommended 
that you keep the Real Time Scanner enabled to ensure your system remains continually free of infection.

The Real Time Scanning setting allows you to switch the On Access scanning between Disabled, Stateful and On Access and 
allows you to specify detection settings and other parameters that are deployed during on-access scans.

To s e t  t h e  Rea l  T ime S c ann i ng  l e v e l

• Click on the 'Real Time Scanning' tab in the 'Scanner Settings' panel. 
• Drag the real time Scanning slider to the required level. The choices available are Disabled (not recommended), 

Stateful (default) and On Access. The setting you choose here are also displayed in the Summary screen.
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• On Access - Provides the highest level of On Access Scanning and protection. Any file opened is scanned before 
it is run and the threats are detected before they get a chance to be executed. 

• Stateful (Default) - Not only is Comodo Antivirus one of the most thorough and effective AV solutions available, it 
is also very fast. CAV employs a feature called Stateful File Inspection for real time virus scanning to minimize the 
effects of on-access scanning on the system performance. Selecting the 'Stateful' option means CAV scans only 
files that have not been scanned since the last virus update - greatly improving the speed, relevancy and 
effectiveness of the scanning. 

• Disabled - The Real time scanning is disabled. Antivirus does not perform any scanning and the threats cannot 
be detected before they impart any harm to the system. 

Detection Settings
• Automatically quarantine threats found during scanning - When this check box is selected, the Antivirus 

moves the file detected to be containing the malware, to Quarantined Items. From the quarantined items the files 
can be restored or deleted at your will (Default = Disabled).  

• Automatically update virus database - When this check box is selected, Comodo Antivirus checks for latest 
virus database updates from Comodo website and downloads the updates automatically, on system start-up and 
subsequently at regular intervals (Default = Enabled). 

• Show alerts/notification messages - Alerts are the pop-up notifications that appear in the lower right hand of 
the screen whenever the on-access scanner discovers a virus on your system. These alerts are a valuable 
source of real-time information that helps the user to immediately identify which particular files are infected or are 
causing problems. Disabling alerts does not affect the scanning process itself and Comodo Antivirus still 
continues to identify and deals with threats in the background. For more details on Antivirus alerts, click here 
(Default = Enabled). 

• Do not scan files larger than - This box allows you to set a maximum size (in MB) for the individual files to be 
scanned during  on-access scanning. Files larger than the size specified here, are not scanned.  (Default = 20 
MB) . 

• Keep an alert on the screen for - This box allows you to set the time period (in seconds)  for which the alert 
message should stay on the screen (Default = 120 seconds).

Click 'OK' for the settings to take effect. 
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 2.8.2 Manual Scanning
The Manual Scanning area allows you to set the parameters that will be implemented when you run an 'On Demand' scan on 
your computer. For example, these options will be used when you click 'Scan Now' from the main 'Summary' screen or 'Run A 
Scan' from the 'Antivirus Tasks' menu.

• Scan archive files - When this check box is selected, the Antivirus scans archive files such as .ZIP and .RAR 
files. You are alerted to the presence of viruses in compressed files before you even open them. These include 
RAR, WinRAR, ZIP, WinZIP ARJ, WinARJ and CAB archives (Default = Enabled) . 

• Automatically update virus database before scanning - Instructs Comodo Antivirus to check for latest virus 
database updates from Comodo website and download the updates automatically before starting an on-demand 
scanning (Default = Enabled) . 

The r e  a r e  s e p a r a t e  upda t e  op t i on s  i n  f o r  r e a l  t ime ,  manua l  and s ch edu l e d  s c ann i ng  
s e t t i ng s .  Di s ab l i ng  he r e  wi l l  sw i t ch  o f f  au t o  -  upda t e s  f o r  t h i s  s c an t y p e  on l y .  
Upda t e s  c an be  down l o ad ed  manua l l y  by  c l i c k i ng  An t i v i r u s  > Upda t e  V i r u s  da t a b a s e .  S e e  
s e c t i on  ' Update Virus Database'  f o r  mor e  de t a i l s  .

• Do not scan files larger than - This box allows you to set a maximum size (in MB) for the individual files to be 
scanned during manual scanning. Files larger than the size specified here, are not scanned (Default = 20 MB).

Click 'OK' for the settings to take effect .

 2.8.3 Scheduled Scanning 
The Scheduled Scanning settings area allows you to determine the scan parameters that will be implemented when a scheduled 
scan takes place.
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You can choose to run scheduled scans at a certain time on a daily, weekly, monthly or custom interval basis. You can also 
choose which specific files, folders or drives are included in that scan by choosing the scan profiles.

The detection settings are as follows:

• Scan archive files - When this check box is selected, the Antivirus scans archive files such as .ZIP and .RAR 
files during any scheduled scan. You are alerted to the presence of viruses in compressed files before you even 
open them. These include RAR, WinRAR, ZIP, WinZIP ARJ, WinARJ and CAB archives (Default = Enabled). 

• Automatically quarantine threats found during scanning - When this check box is selected, the Antivirus 
moves the file detected to be containing the malware, to Quarantined Items. From the quarantined items the files 
can be restored or deleted at your will (Default = Disabled).

• Automatically update virus database before scanning - When this check box is selected, Comodo Antivirus 
checks for latest virus database updates from Comodo website and downloads the updates automatically, before 
the start of every scheduled scan (Default = Enabled). 

The r e  a r e  s e p a r a t e  upda t e  op t i on s  i n  f o r  r e a l  t ime ,  manua l  and s ch edu l e d  s c ann i ng  
s e t t i ng s .  Di s ab l i ng  he r e  wi l l  sw i t ch  o f f  au t o  -  upda t e s  f o r  t h i s  s c an t y p e  on l y .  
Upda t e s  c an be  down l o ad ed  manua l l y  by  c l i c k i ng  Ant iv i rus > Update Vi rus database.  S e e  
s e c t i on   ' Update Virus Database'  f o r  mor e  de t a i l s .  

• Show Scanning progress - When this check box is selected, a progress bar is displayed on start of a scheduled 
scan. Clear this box if you do not want to see the progress bar (Default = Enabled).

•  Do no t  s c an f i l e s  l a r g e r  t h an  -  Th i s  box a l l ow s  you t o  s e t  a  max imum s i z e  
( i n  MB) f o r  t h e  i n d i v i du a l  f i l e s  t o  be  s c ann ed  du r i ng   s ch edu l e d  s c ann i ng .  
F i l e s  l a r g e r  t h an  t h e  s i z e  s p e c i f i e d  he r e ,  a r e  no t  s c ann ed (D e f a u l t  = 2 0  
MB).  

Click 'OK' for the settings to take effect. 

 2.8.4 Exclusions
The Exclusions tab in the Scanner Settings panel displays a list of applications/files for which you have selected Ignore in the 
Scan Results window of Run a Scan option or added to the Exclusions from an Antivirus alert.
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All items listed and all items added to the 'Exclusions' list is excluded from all future scans of all types.

Also, you can manually define trusted files or applications to be excluded from a scan .

To de f i n e  a  f i l e / app l i c a t i on a s  t r u s t e d and t o  be ex c l uded f r om 
s c ann ing

1 . Click 'Add'. 

You now have 2 methods available to choose the application that you want to trust - 'Browse Files...' and 'Browse 
Running Processes'.

• Browse Files...  - This option is the easiest for most users and simply allows you to browse the files which you 
want to exclude from a virus scan.

• Browse Running Processes - As the name suggests, this option allows you to choose the target application 
from a list of processes that are currently running on your computer. 

When you have chosen the application using one of the methods above, the application name appears along with its location. 

2. Click 'OK' for the settings to take effect.

 3 More Options-Introduction
The More Opt i on s  i n t e r f a c e  c on t a i n s  s e v e r a l  a r e a s  r e l a t i ng  t o  ov e r a l l  
c on f i gu r a t i on  a s  we l l  a s  handy  u t i l i t i e s  and s h o r t c u t s  t o  he l p  enhanc e  
and imp r ov e  you r  exp e r i e n c e  wi th  Comodo An t i v i r u s .
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It can be accessed at all times by clicking on the 'More'   link  from the navigation panel. 

Click the links below to see detailed explanations of each area in this section. 

• Preferences: Allows the user to configure general Comodo Antivirus settings (password protection, update 
options, language, theme and so on.) 

• Manage My Configurations: Allows the user to manage, import and export their Comodo Antivirus configuration 
profile. 

• Diagnostics: Helps to identify any problems with your installation. 
• Check For Updates: Launches the Comodo Antivirus updater. 
• Browse Support Forums: Links to Comodo User Forums. 
• Help: Launches the online help guide. 
• About: Displays version and copy-right information about the product.

 3.1 Preferences
The Preferences menu in More section allows you to configure various options related to the operation of Comodo Antivirus.
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To open P r e f e r en c e s  d i a l o g  box

• Click 'Preferences' in 'More' screen. 

It has the following tabs to make your settings:

• General 
• Parental Control 
• Language
• Logging
• Update 

 3.1.1 General Settings

• Automatically Check for the program updates - This option determines whether or not Comodo Antivirus should 
automatically contact Comodo servers for updates. With this option selected, Comodo Antivirus automatically checks 
for updates every 24 hours AND every time you start your computer. If updates are found, they are automatically 
downloaded and installed. We recommend that users leave this setting enabled to maintain the highest levels of 
protection. Users who choose to disable automatic updates can download them manually by clicking 'Check for 
Updates' in the 'More...' section (Default = Enabled).

• Show the balloon messages - These are the notifications that appear in the bottom right hand corner of your screen 
- just above the tray icons. Usually these messages like 'Comodo Antivirus is learning' and are generated when these 
modules are learning the activity of previously unknown components of trusted applications. Clear this check box if 
you do not want to see these messages (Default = Disabled). 

 3.1.2 Parental Control Settings
The 'Parental Control' tab allows you to configure password protection for Comodo Antivirus.
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• Enable password protection for settings - Selecting this option activates password protection for all important 
configuration sections and wizards within the interface. If you choose this option, you must first specify and confirm a 
password by clicking the 'Change Password... ' button. You are asked for this password every time you try to access 
important configuration areas  Antivirus Tasks areas require this password before allowing you to view or modify their 
settings).

This setting is of particular value to parents, network administrators and administrators of shared computers to prevent 
other users from modifying critical settings and exposing the machine to threats (Default = Disabled). 

• Suppress Antivirus alerts when password protection is enabled - If selected, no Antivirus Alerts are displayed 
when password protection is enabled. Parents and network admins may want to enable this setting if they do not 
want users to be made aware when an Antivirus alert has been triggered. For example, a virus program may be 
attempting to copy itself and infect user's computer without permission or knowledge of the user. Usually, the Antivirus 
would generate an alert and ask the user how to proceed. If that user is a child or an inexperienced user then they 
may unwittingly click 'allow' just to 'get rid' of the alert and/or gain access to the website in question - thus exposing the 
machine to attack. Selecting this option blocks the activity of the virus but does not generate an alert (Default =  
Disabled). 

 3.1.3 Language
The  Appearance tab allows you  to  choose the interface language  and customize the look and feel  of  Comodo Antivirus 
according to your preferences. Use the drop-down menu to switch between installed themes.

Language Settings
Comodo Antivirus is available in multiple languages. You can switch between installed languages by selecting from the 
'Language' drop-down menu (D e f a u l t  = Eng l i s h  (Un i t e d  S t a t e s ) ) .

In order for your language to take effect, you must restart the Comodo Antivirus application. 

 3.1.4 Log Settings
By default, Comodo Antivirus maintains a log of all the Antivirus, which can be accessible by clicking 'View Antivirus Events' 
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from the Antivirus Tasks interface. 

The 'Logging' tab of the 'Preferences' interface allows you to configure how CAV should behave once this log file reaches a 
certain size and also allows you to disable the logging of specific types of event.

If the log file's size exceeds (MB): Enables you to configure for deleting or moving the log file if it reaches a specified size in 
MB. You can decide on whether to maintain log files of larger sizes or to discard them depending on your future reference needs 
and the storage capacity of your hard drive.

• Specify the maximum limit for the log file size (in MB) in the text box beside 'If the log file's size exceeds (MB)' 
(Default = 20MB).

If you want to discard the log file if it reaches the maximum size, select  'Delete it and create a new file'. Once the log file 
reaches the maximum size, it will be automatically deleted from your system and a new log file will be created with the log of 
events occurring from that instant (Default = Enabled).
If you want to save the log file when it reaches the maximum size, select 'Move it to' and select a destination folder for the log 
file (Default = Disabled).

The selected folder path will appear beside 'Move it to'.
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Once the log file reaches the maximum size, it will be automatically moved to the selected folder and a new log file will be 
created with the log of events occurring from that instant.

Check Boxes:

The check boxes allow you to disable logging of events according to your preferences.

• Disable Antivirus logging - Instructs Comodo Antivirus to not to log Antivirus events (Default = Disabled).

 3.1.5 Update Settings
The Update tab allows you enable/disable the CAV program updates and to select the host from which the updates are to be 
downloaded. By default, the URL of the Comodo Server is entered as an available host.  

• If you want to download the updates always from the Comodo servers, you can leave the setting as it is (Default  
= Enabled).

• If you are connected to a local network and the CAV program updates are available at an HTTP Server or at any 
of the other computers in your network running Comodo Offline Updater, you can add the computers as hosts in 
this area.

• To add a host click 'Add' and enter the url or IP address of the host in the next row that appears. 
• Repeat the process for adding multiple hosts. 
• Select the host by using the Move Up and Move Down buttons. 

CAV will automatically check the host specified here and download the updates from the host even when 
you are offline.  

• Click 'OK' for your settings to take effect.

Note: CAV program updates can also be checked manually. Click More Options > Check For Updates if you wish to update 
manually. Click here to view the help page on manual updates.
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 3.2 Manage My Configurations
Comodo Antivirus allows you to maintain, save and export multiple configurations of your security settings. This is especially 
useful if you are a network administrator looking to roll out a standard security configuration across multiple computers. If you 
are upgrading your system and there is a need to un-install and re-install Comodo Antivirus, you can export your configuration 
settings to a safe place before un-installation. After re-installation, you can import the configuration settings to take effect in your 
newly installed Comodo Antivirus. 

This feature is also a great time saver for anyone with more than one computer because it allows you to quickly implement your 
security settings on other computers that you own without having to manually re-configure them.

• Comodo Preset Configurations
• Importing/Exporting and Managing Personal Configurations

 3.2.1 Comodo Preset Configurations
Comodo Antivirus ships with preset configurations that strike a good balance between security and usability. The profile that is 
currently in use is the 'Active' profile.

Important Note: Any changes you make to settings over the course of time are recorded in (and will update) the 'active' 
profile. Exporting the active profile will, therefore, export your settings as they currently stand. 

Before modification, the 'Comodo Internet Security' profile has the following  default settings:
• Automatic Program Updates - ON
• Automatic Virus Updates - ON
• Logging - ON
• Max. Log File Size - 20 MB
• Do not scan files larger than - 20 MB (all scanner types)
• Real Time Scanning - Stateful

Over time, you may have made changes that have altered this profile. If you want to restore the settings above, then click 
'Restore Defaults'.

If you wish to switch to Internet Security option, you can select the option using My Configurations interface. 
• Image Execution Control is disabled.
• Computer Monitor/Disk/Keyboard/DNS Client access/Window Messages are NOT monitored.
• Only commonly infected files/folders are protected against infection.
• Only commonly exploited COM interfaces are protected.

 3.2.2 Importing/Exporting and Managing Personal Configurations

To a c c e s s  Con f i gu r a t i on s  i n t e r f a c e  

1 . Navigate to 'More > Manage My Configurations'.
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This interface has the follow preset choice: 

• COMODO - Internet Security
The currently active configuration is indicated as 'Active' in this interface.

2 . Click the area on which you would like more information:

• Export my configuration to a file 
• Import a saved configuration from a file 
• Select a different active configuration setting 
• Delete a inactive configuration profile 

Export my configuration to a file

To expor t  you r  cu r r en t l y  a c t i v e  con f i gu r a t i on

1 . Click the 'Export' button. 

2 . Type a file name for the profile (e.g., 'My CIS Profile') and save to the location of your choice.  

A confirmation dialog appears for the successful export of the configuration.

Import a saved configuration from a file
Importing a c on f i gu r a t i on  profile allows you to store any profile within Comodo Antivirus. Any profiles you import do not 
become active until you select them for use.

To impo r t  a  pro f i l e

1 . Click the 'Import' button. 

2 . Browse to the location of the saved profile and click 'Open'. 
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3 . In the 'Import As' dialog that appears, assign a name for the profile you wish to import and click 'OK'. 

A confirmation dialog appears indicating the successful import of the profile.

Once imported, the configuration profile is available for deployment by selecting it.

Comodo Antivirus 2011 User Guide | © 2014 Comodo Security Solutions Inc. | All rights reserved                                                     78



Com o d o  An t i v i r u s  -  Us e r  Gu i d e

Select and Implement a different configuration profile
The Activate option allows you to quickly switch between configuration profiles. 

To s e l e c t  a  d i f f e r en t  con f i gu r a t i on

1 . Click on the profile you want to select and activate. 

2 . Click the 'Activate' button.

A confirmation dialog appears.

The selected configuration is activated.
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Delete an inactive configuration profile
You can remove any unwanted configuration profiles using the 'Remove' button. You cannot delete the profile that Comodo 
Antivirus is currently using - only the inactive ones. For example if the COMODO - Internet Security is the active profile, you can 
only delete the inactive profiles.

To r emove  an unwan t ed pro f i l e

1 . Select the profile and click 'Remove' button. A confirmation dialog appears. 

2 . Click 'Yes' if you are sure to delete. The selected profile is removed from the list and a confirmation dialog appears. 
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 3.3 Diagnostics
Comodo Antivirus has it's own integrity checker. This checker scans your system to make sure that the application is installed 
correctly. It checks your computer's:

• File System - To check that all of Comodo's system files are present and have been correctly installed.
• Registry - To check that all of Comodo's registry keys are present and in the correctly installed.
• Checks for the presence of software that is known to have compatibility issues with Comodo Antivirus.

The results of the scan are shown in the following pop-up window. If your installation does not have any errors the 
following dialog is displayed.

If the diagnostics utility has found some errors in the installation, the following dialog is displayed.
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Click 'Yes'. The diagnostics utility automatically fixes the problems and prompts you to restart the computer.

Restart your computer for the changes to take effect.

 3.4 Check for Updates
Updates on Comodo Antivirus can be downloaded and installed at any time by clicking the 'Check for Updates' link in 'More'  
Options interface. 
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To che ck f o r  av a i l ab i l i t y  o f  upda t e s

• Click 'Start'. 
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On completion of checking, the panel shows the availability of updates.

The 'Update Details' link will lead you to the web page that provides release notes for the latest version of the application.

To i n i t i a t e  t h e  upda t e  pro c e s s

• Click the 'Start' button in the panel. 

Note: If you want to download and install the updates later, click the 'Cancel' button.

After the installation process is completed, Click 'OK'. You are then asked to restart the system.

• Click 'Yes' to reboot the system now or 'No' to reboot at a later time. 

 3.5 Browse Support Forums
The fastest way to get further assistance on Comodo Antivirus is by posting your questions on Comodo Forums, a message 
board exclusively created for our users to discuss anything related to our products.

• Click the Browse Support Forums link to be taken straight to the website at http://forums.comodo.com. 
Registration is free and you'll benefit from the expert contributions of developers and fellow users alike. 
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Online Knowledge Base
We also have an online knowledge base and support ticketing system at http://support.comodo.com. Registration is free.

 3.6 Help 
Clicking the Help link in the More section opens the online help guide hosted at http://help.comodo.com/. Each area has its 
own dedicated page containing detailed descriptions of the application's functionality.
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You can also print or download the help guide in .pdf format from the webpage.

 3.7 About
Click the 'About' option in the 'More' Screen to view the 'About' information dialog. 

The 'About' dialog displays the copyright information and the information on the version number of Comodo Antivirus on your 
computer. 
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Abou t  Comodo
The Comodo companies are leading global providers of Security, Identity and Trust Assurance services on the Internet. Comodo 
CA offers a comprehensive array of PKI Digital Certificates and Management Services, Identity and Content Authentication 
(Two-Factor - Multi-Factor) software, and Network Vulnerability Scanning and PCI compliance solutions. In addition, with over 
10,000,000 installations of its threat prevention products, Comodo Security Solutions maintains an extensive suite of endpoint 
security software and services for businesses and consumers. 

Continual innovation, a core competence in PKI and a commitment to reversing the growth of Internet-crime distinguish the 
Comodo companies as vital players in the Internet's ongoing development. Comodo, with offices in the US, UK, China, India, 
Romania and the Ukraine, secures and authenticates the online transactions and communications for over 200,000 business 
customers and millions of consumers, providing the intelligent security, authentication and assurance services necessary for 
trust in on-line transactions.

Comodo Security Solutions, Inc.
1255 Broad Street
Clifton, NJ 07013
United States

Tel : +1.888.266.6361          

Email: Sales@comodo.com

Comodo CA Limited
3rd floor, Office Village Exchange Quay

Trafford Road, Salford, Manchester M5 3EQ

United Kingdom

Tel :  +44 (0) 161 874 7070

Fax : +44 (0) 161 877 1767
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